Building Faculty Websites in Cascade
A Guide for Site Administrators

By the McCormick Office of Marketing and External Communications

Version 1.0
Updated March 14, 2013
# Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>PURPOSE</td>
<td>4</td>
</tr>
<tr>
<td>REQUESTING YOUR WEBSITE</td>
<td>4</td>
</tr>
<tr>
<td>RESOURCES</td>
<td>4</td>
</tr>
<tr>
<td>LOGGING IN TO CASCADE</td>
<td>5</td>
</tr>
<tr>
<td>THE HOME SCREEN</td>
<td>7</td>
</tr>
<tr>
<td>THE NAVIGATION PANEL</td>
<td>9</td>
</tr>
<tr>
<td>THE DASHBOARD</td>
<td>11</td>
</tr>
<tr>
<td>DRAFTS</td>
<td>12</td>
</tr>
<tr>
<td>“Submit” vs. “Publish”</td>
<td>12</td>
</tr>
<tr>
<td>RECENT HISTORY</td>
<td>13</td>
</tr>
<tr>
<td>OTHER COMPONENTS</td>
<td>13</td>
</tr>
<tr>
<td>THE TOOLBAR</td>
<td>14</td>
</tr>
<tr>
<td>CREATING CONTENT IN CASCADE</td>
<td>15</td>
</tr>
<tr>
<td>PLANNING AHEAD</td>
<td>15</td>
</tr>
<tr>
<td>BUILDING YOUR WEBSITE STRUCTURE</td>
<td>16</td>
</tr>
<tr>
<td>CREATING FOLDERS</td>
<td>16</td>
</tr>
<tr>
<td>CREATING INDEX PAGES</td>
<td>20</td>
</tr>
<tr>
<td>CREATING OTHER WEBPAGES (SECOND-LEVEL NAVIGATION)</td>
<td>23</td>
</tr>
<tr>
<td>CREATING THIRD-LEVEL NAVIGATION</td>
<td>25</td>
</tr>
<tr>
<td>FOLDER ORDER: CHANGING YOUR SITE'S NAVIGATION</td>
<td>25</td>
</tr>
<tr>
<td>NAMING FILES, FOLDERS, AND WEBPAGES</td>
<td>26</td>
</tr>
<tr>
<td>CREATING AND UPLOADING FILES</td>
<td>27</td>
</tr>
<tr>
<td>UPLOADING DOCUMENT (NON-IMAGE) FILES</td>
<td>28</td>
</tr>
<tr>
<td>PREPARING IMAGES FOR UPLOAD</td>
<td>29</td>
</tr>
<tr>
<td>UPLOADING IMAGE FILES</td>
<td>30</td>
</tr>
<tr>
<td>GUIDELINES FOR CREATING NEW CONTENT</td>
<td>31</td>
</tr>
<tr>
<td>CREATING WEBPAGE CONTENT</td>
<td>31</td>
</tr>
<tr>
<td>THE CASCADE EDITOR TOOLBAR</td>
<td>32</td>
</tr>
<tr>
<td>COPYING AND PASTING</td>
<td>36</td>
</tr>
<tr>
<td>BASIC FORMATTING</td>
<td>37</td>
</tr>
<tr>
<td>HEADINGS AND SUBHEADINGS</td>
<td>37</td>
</tr>
<tr>
<td>INSERTING AND EDITING LINKS</td>
<td>38</td>
</tr>
<tr>
<td>INSERTING ANCHOR LINKS</td>
<td>39</td>
</tr>
<tr>
<td>INSERTING IMAGES</td>
<td>41</td>
</tr>
<tr>
<td>WORKING WITH IMAGES</td>
<td>43</td>
</tr>
<tr>
<td>ASSIGNING AN IMAGE CLASS</td>
<td>43</td>
</tr>
<tr>
<td>ALIGNING AN IMAGE TO THE RIGHT OR LEFT</td>
<td>43</td>
</tr>
<tr>
<td>ALIGNING AN IMAGE TO THE CENTER</td>
<td>45</td>
</tr>
</tbody>
</table>
Purpose
This guide is intended as a comprehensive resource for those creating faculty research group or laboratory websites in the Cascade content management system. These sites will use a standard McCormick-branded template.

This guide includes step-by-step instructions for common tasks, content guidelines, and helpful hints regarding best practices. Please refer to it throughout the process of building and maintaining your faculty website.

Requesting Your Website
Before you begin working in Cascade, you will need to request that your website be set up by McCormick IT.

Send an e-mail to web-updates@mccormick.northwestern.edu stating that you are requesting a faculty website in Cascade using the standard template and provide:

- the faculty member's name
- Net ID
- department
- the names and Net IDs of anyone else in the research group or lab who will need access to edit the website's content.

McCormick IT will respond with further instructions. Once the site has been set up, IT will create a folder for the website in Cascade which you can access.

After you log in to Cascade using your Net ID and password (see “Logging in to Cascade” [page 5] for login instructions), you will immediately be able to start building the site, making it public when you are ready.

The web address (URL) for your faculty web site will follow this format:

http://faculty.mccormick.northwestern.edu/john-smith

Resources
In addition to this manual, there are several resources provided by McCormick to assist you in building and maintaining your faculty website.

On the McCormick website, you can find this manual and other useful information:
http://www.mccormick.northwestern.edu/marketing/web/faculty-websites.html

While intended for McCormick staff who are maintaining departmental websites, additional information about working in Cascade and best practices for formatting web content are available here:

http://www.mccormick.northwestern.edu/marketing/web/index.html

It is also highly recommended that you adhere to the style rules listed in this guide. In addition, you may refer to the Northwestern University Style Guide:

http://www.northwestern.edu/univ-relations/publications/resources/styleguide.html

**Logging in to Cascade**

1. Open a browser and enter the following URL (or click this link):
   http://mordac.itcs.northwestern.edu/

   You will be redirected to the NU Online Passport Single Sign-On page.

2. Enter your Net ID and password. Then press “Enter” or click “Log In.”
   Click “Continue” if a security warning message pops up.

![Security Warning](security_warning.png)

This security warning is not an indicator of an actual security threat; it can safely be ignored while using Cascade.
NOTE: On occasion after logging into Cascade, your browser may indicate you are logged in, but not take you to Cascade’s Home Screen.

Should this error occur, simply return to the login URL (http://mordac.itcs.northwestern.edu/) and your browser will automatically redirect you to the Home Screen, so you can begin working in Cascade.

**Best Practice:**
McCormick IT recommends Cascade users work in Chrome or Firefox. Internet Explorer also works, but Chrome and Firefox generally perform better.

**Mac users** are also advised to use Chrome or Firefox. Cascade is accessible through Safari as well.

When previewing changes to your website in a browser, it is suggested to avoid using Firefox since you may need to force its cache to refresh in order to load your site’s latest content changes.
The Home Screen
The first thing you’ll see upon logging in to Cascade is the Home Screen, which serves as a sort of home base for your work while logged into Cascade.

The Home Screen consists of three main areas:

- The **navigation panel**, which runs along the left side, is used to locate and select webpages, folders, images, and files (also called “assets”).

- The **toolbar**, which runs across the top of the screen, allows you to perform a set of actions, such as creating an asset.

- The **dashboard / main panel**, which takes up the majority of the screen, changes according to the task you are performing.

**What’s an Asset?**
In Cascade, the word “asset” is a blanket term for any object loaded into, or created in, the Content Management System.

An asset can refer to:

- a web page
- a PDF
- an external link
- an image file (photo)
- an MS Word document
- an internal link
- a folder
- an MS Excel document

You’ll learn more about creating and managing assets below.
You’ll notice a drop-down menu at the top of your screen, toward the left. Clicking it reveals the sites you have access to view and edit in Cascade.

The drop-down menu may display “Global” by default; use it to select “McC-MAIN-FacultySites.” That is where your website is kept.

In the content tree on the left, navigate to and then select the folder that contains your website’s name.
The Navigation Panel
The navigation panel uses the “tree” structure that will be familiar to any user of Windows: a listing of folders is visible, and the user clicks on the small “+” next to each folder to view its contents. Clicking the “+” or “-” expands and contracts that folder’s content, as shown below.

You will see a “Base Folder,” and then under that in the content tree, a folder for your website. Select that folder.

All of your website content will be kept in the folder with your website’s name.

Throughout this guide, the name “john-smith” is the name of our website folder.
To begin browsing your site in Cascade, click on the folder in the navigation panel that is named for your website to expand the folder tree.

Once the folder expands, the sub-folders and page assets are displayed in the same directory structure that exists when published. Choosing a page in the folder, such as “index,” will bring up a preview of the web page in the main system window, just as it would appear online.
**The Dashboard**

Cascade’s Dashboard features helpful shortcuts to commonly performed tasks. These shortcuts are grouped into three areas, and these areas are arranged into subgroups, as seen below:

1. **Create / Manage Content**
2. **Outstanding Items**
3. **Current Activity**

We’ll examine each of these, with the more relevant functions listed first.
**Drafts**
A “Draft” is exactly what the name implies: a working, but not complete, copy of a webpage with changes in progress. Once a page has already been created and submitted in Cascade, a button called “Save Draft” will appear at the bottom of the Edit window the next time you visit that page.

To save a page as a draft, click the “Save Draft” button at the bottom of the Edit window.

Drafts are useful for when you’re working on a page, but need to stop and focus on something else for a while. If you want to ensure no one else makes changes to the page while you’re working on a draft, simply lock the asset.

**“Submit” vs. “Publish”**
When you make changes to any page, folder, or other asset in Cascade, you will see a button at the bottom of that window called **“Submit.”** Clicking the Submit button saves your changes in Cascade. If you don’t click “Submit,” your changes will not be saved.

When you return to that page or file in Cascade, even after logging out of the system, it will display the most recent updates that were submitted. **NOTE:** Clicking the Submit button does NOT put your pages or files on the web.

**Publishing** is the process by which your pages, folders, or other assets are copied from Cascade and put onto one of McCormick’s public web servers. Publishing a page, folder, or other asset, makes that content visible on the web. Conversely, unpublishing removes content from the web.

For instructions on how to publish your content, visit the section of this guide titled “Publishing Your Webpages” [page 64].
**Recent History**

Often, as you’re working within the system, you’ll want an easy way to return to content you were working on earlier. The History function lets you see a list of your most recently viewed or edited assets.

Recent History is displayed on the Dashboard; you can also view it by clicking the History button, located in the Toolbar.

![Dashboard with Recent History highlighted](image)

Clicking the History button in the toolbar (or clicking the “Recent History” link on the Dashboard) takes you to a history screen that shows a list of your most recently viewed assets. You can jump to any of those assets by clicking on its system name in the list.

**Other Components**

- **Starting Page:** Generally this is the home page of the site you’re currently signed in to.

- **Recycle Bin:** Contains assets you and other site users have recently deleted. These assets are kept in case of accidental deletion. NOTE: assets in the Recycle Bin are deleted permanently after 15 days.

- **Messages:** Cascade contains a messaging function that’s primarily used to notify users when their pages are successfully published or un-
published. These messages contain detailed information on errors, if any, that may have occurred during the publishing process.

This function also allows users to communicate with each other from within the CMS, but is rarely used as such.

**The Toolbar**
Cascade’s toolbar is similar to those in most desktop applications, like Microsoft Word or Excel.

Some toolbar items are simply buttons; others are drop-down menus (indicated by a double downward arrow).

The functions available in the Toolbar are similar to those found on the Dashboard, but are consistently available, unlike the Dashboard.

- The Cascade Swirl menu gives you access to the Publisher screen and allows you to set your User Preferences.

- The Home button returns you to the Cascade Server Home screen.

- The New menu is used to create new assets.

**The Publisher Screen**
Clicking the Cascade Swirl button, then navigating to “Publisher” and “Active Jobs” shows a list of pages currently publishing in Cascade throughout Northwestern (not just McCormick sites).

You can use the Publisher to see if pages you’ve recently published have transitioned to the live server yet. Single pages generally publish almost immediately; larger folders or entire sites frequently take longer.
• The History button shows you where you have been since you logged in.

• The Help menu contains in-system help (though this guide should be considered the authoritative document for McCormick Web editors).

• The “Quick Links” link causes a drop-down menu with access to the items on your Dashboard to appear.

Creating Content in Cascade
Building a website in Cascade starts with creating a folder structure: a collection of folders containing specifically arranged pages, images, documents, and other files. Cascade takes this structure, applies a design template to it, and generates your website.

As you build your site in Cascade, you’ll work with “assets” extensively. Assets are folders, PDFs, Word documents, images, files, and web pages in Cascade.

Before you learn how to create and manage folders, it’s important to understand how Cascade uses the information you provide when creating and modifying them.

Planning Ahead
It is recommended that you plan your site’s structure ahead of time, before you start building folders and pages in Cascade. This will save you time and hassle later.

• What sections do you absolutely need? Plan your site accordingly. Think about the structure of peer websites that are easy to navigate. Many faculty research group sites have sections such as About, News, People, Research, Projects, Publications, Links, Contact, etc. You may or may not need all those sections.

• It’s a good idea to start simply and add sections to your website later on as desired. A clean and simple website that’s easy for visitors to navigate is much preferred over a complicated website that isn’t well organized, complete, or up-to-date.

• Keep in mind that you will need to maintain and update all the content on your website.
Building Your Website Structure

Your site’s navigation is based on the structure and order of the folders within its main directory folder and the subfolders contained within each folder.

This type of navigation is called “Dynamic Navigation,” because it’s automatically generated and updated by how you build your site’s folder structure.

This example shows a live screenshot of a site’s left navigation with an inset image on the right that shows the contents of that site’s main directory folder in Cascade.

Creating Folders

The first step in creating your site’s structure is to create the folders that organize your content.

It is highly recommended that you create a folder in Cascade for each top-level link or section you would like to appear in your left-hand navigation, even if you only plan to have one webpage in that section. There are two reasons for using folders this way:

- Should you decide to add more webpages or content to a section of your site in the future, you will already have the folder in place that is properly named and ready to contain those additional pages.

- Should you decide to expand an area of your website from a single page to a section containing multiple pages, without a proper folder structure, you would need to change the System Name and location of that one page and possibly others. Since the System Name becomes part of a page’s URL,
this could lead to multiple broken links for visitors who return to your site after the adjustment.

It’s best to start off with a folder structure that allows your website to grow.

Since Cascade generates your site’s navigation from folders and their names, it’s important to name them properly. This begins when you create a folder.

1. For this example, we’ll create the “research” folder which will contain pages telling visitors about the research your group conducts.

2. In the Menu bar, click “New,” and then click “Folder.”

3. Enter the folder name in “System Name” field. In this case, call it “research.”

   NOTE: The system names of all assets in Cascade, including folders, should be lower-case and should substitute hyphens for spaces. No Cascade Asset should contain spaces in its system name. In addition, it’s important to use keywords in your System Names. The System Name becomes part of the URL path.
4. Make sure that the “Parent Folder” shown is the one where you want the new asset to “live.” You can change the Parent Folder by clicking the link next to the folder icon. This will open a new window that will let you choose the correct Parent Folder.

In our example, since we want the “research” folder to appear as a top-level link in the site’s navigation, put it directly under your main site’s folder called “john-smith.” Select the folder and click “Confirm.”

5. The section marked “Inline Metadata” contains the Display Name and Title fields for your new folder.
A Cascade asset’s **Display Name** is the name that appears in the left navigation panel and the page’s breadcrumb navigation.

An asset’s **Title** is the name that appears at the top of the page and in the title bar of a site visitor’s web browser:

Enter a Display Name and a Title. **Both Display Names and Titles should be brief and descriptive.**

Display Names should substitute “&” for the word “and” since space is limited in the left sidebar. In our example, you can name them both “Research.”

6. In the area marked “Metadata Set,” there are two checkboxes that should be checked by default:

   **“Include when publishing”** means that this folder and its contents can be published with the rest of your site, so they will appear on the live
website. For more information about publishing pages and folders, please see Publishing Your Webpages below.

**Include when indexing** means that the pages within this folder will be included (and show up in) the left-hand navigation of your site.

7. Click “Submit.”

**NOTE:** Folders such as “docs” and “images” will not appear in your website’s left-hand navigation because their “Display Name” fields are left blank.

**Creating Index Pages**

The index page is the webpage that a browser automatically displays when a visitor navigates to a folder. It’s the default or “start page” for visitors to that section of your website.

You should create an index page for each folder you create on your website (except for the “images” and “docs” folders).

For example, the homepage of your website – the page that a visitor sees first when they visit your website – is the index page that is contained under your main directory folder in Cascade.

- To create an index page, select “New” in the Toolbar and choose “Web Page” from the dropdown menu.

**Please Note:**

Your faculty website will already have a “Site Index” page – a **homepage** for your website – prepared for you.

You do not need to create an index page for your entire website, only for the additional folders you create.
• On the Create page in Cascade, give your page a System Name of “index.”
• Next to “Parent Folder,” navigate to the site folder where you want to put your index page. Click “Confirm” at the bottom of the page when finished.
• Under Inline Metadata, give your page a Display Name and Title.
The **Display Name** for an index page will appear in the breadcrumb navigation of a page. (Since this is an index page, the **Display Name of the folder** in which it is kept will display in the left-hand navigation of your website.)

The **Title** will appear at the top of the content area of your page and also in the browser’s title bar.

To improve your search engine optimization (SEO), complete the Keywords and Description sections. (See “Optimizing Your Content” for more information about improving SEO [page 57].)

Refer to “Creating Webpage Content” for detailed instructions about adding and editing the content on your webpages.

- When finished, click the “Submit” button at the bottom of the page.

Repeat the above process for any folder you have created.
Creating Other Webpages (Second-Level Navigation)

Pages that are not the “index” page in a folder will appear to a visitor as a second-level of links in your website’s left-hand navigation.

The process of creating one of these pages is nearly identical to that of creating a new folder, index page, or other asset:

1. (Optional): Navigate to the folder where you want to create a new webpage. (If you don’t do this now, you can choose the destination folder in a moment.)

3. Give your new webpage a System Name.

   Since your System Name becomes part of that page’s URL, it is best to give your page a System Name that uses lowercase keywords separated by hyphens. Do not use any spaces.

4. If you didn’t already do so in Step 1, select the “Parent Folder” link and navigate to the site folder where you want to put your new page.

5. Enter your new page’s Display Name and Title in the appropriate fields, and (if you have it ready) place your new page’s content in the main content field.

6. Click “Submit.”

NOTE: You will need to manually publish your changes; see “Publishing Your Webpages” [page 64] for more information on publishing pages.
Creating Third-Level Navigation

The website template used by McCormick allows for the left-hand navigation to display up to three levels at once, which enables you to better organize areas with a large amount of content.

If you would like to create a third level of navigation, create a new folder inside one of your other folders. Then repeat the steps above to create an index page and additional webpages (as needed) inside that new folder.

NOTE: You will need to publish all folders affected by your changes in order for the left-hand navigation on your website to reflect the latest updates.

Folder Order: Changing Your Site’s Navigation

This section explains how to change the order of folders, subfolders, and assets in Cascade.

The left-hand navigation of your website is determined by the order of the folders and assets in Cascade. You can reorder the folders and the webpages contained within those folders, which will then change the order of links in your site’s left-hand navigation.

In this example, we’ll be changing the left navigation in the main directory of your site.

1. In the navigation panel, click on your site’s folder or a desired subfolder (Click the folder link, not the “+” sign next to it.).

2. Click the column header marked
“Order.” The assets should reorder from lowest to highest. If they don’t, click “Order” again to reverse the sort order. Note that this sorting is necessary for any re-ordering to work.

3. Click and drag each folder/file to the desired position, or use the arrows at right to move them up or down in the order. Your changes will be saved automatically when you navigate away from the folder.

**NOTE:** In order for these changes to display on the web, you must re-publish the entire folder you’ve re-ordered. If you’re reordering the main left-hand navigation of your site, you’ll need to republish your entire site folder for those changes to appear. See “Publishing Your Webpages” [page 64] to learn more about publishing your website folders.

**Naming Files, Folders, and Webpages**
Since asset filenames become part of their URL addresses and also affect how readily your website appears in search results, it is important to follow certain conventions as you name your assets in Cascade.

When providing the **System Name** of any asset in Cascade, please follow these guidelines:

- System Names should not contain any spaces and should not be unnecessarily long.
- They should use keywords, all lowercase, separated by hyphens.
- They should not include dates that will expire.

**Here are examples of good and bad System Names:**

<table>
<thead>
<tr>
<th><strong>GOOD</strong></th>
<th><strong>BAD</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>catalysis-research-laboratory.jpg</td>
<td>CatReschlab.jpg</td>
</tr>
<tr>
<td>john-smith.jpg</td>
<td>John Smith Good Headshot1.jpg</td>
</tr>
<tr>
<td>john-smith-publications.pdf</td>
<td>Johnsmith_Pubs_9-12-11.pdf</td>
</tr>
<tr>
<td>smith-group-newsletter.pdf</td>
<td>SmithResearchgroupNewsletterApril2012.pdf</td>
</tr>
</tbody>
</table>
Following good hygiene when naming your assets also saves you time and trouble as you organize and maintain your website content in Cascade.

**Creating and Uploading Files**
You may want to include documents (PDFs, Word documents, Excel spreadsheets) or image files on your website. To do so, you first need to upload them into Cascade.

By doing this you’ll be creating what’s called an **asset**. As explained above in “Creating Content in Cascade” [page 15], an asset is any object created in the Cascade content management system and includes images, documents, web pages, or links.

**This section explains how to upload your files and create those assets in Cascade.**

Once your document or image assets have been created in Cascade, you can link to them or display the images on your webpages, as explained below in “Creating Webpage Content” [page 31].

---

**How do I Hide an Asset?**
To keep a Cascade asset from appearing in the left-hand navigation of your site:

1. Select a page or folder in Cascade and choose the “Edit” tab.

2. Underneath the “Edit” tab, select “Metadata” in the blue Menu bar.

3. On this page, under the “Custom Metadata” section, select “no” where it says “Show in Navigation” (for a webpage) or “Display Enclosed Pages In Navigation?” (for a folder).

4. **Re-publish the entire directory** in which your asset is placed. This will update your site’s left navigation.

**NOTE:** After publishing, you may need to refresh your browser more than once to see the updated page.
**Uploading Document (Non-Image) Files**

1. In the Menu Bar, select “New” > “Document – PDF TXT DOC PPT POT XLS.”

2. The main panel will change to the “New File” panel. At the bottom of the area labeled “Data” you’ll see a field marked “File Upload” with a “Browse ...” button next to it. Click “Browse.”

3. A file-browsing window will open, allowing you to navigate to and select the file you wish to upload; do so and click OK.

4. On the “System” tab of the “New File” panel:
   a. **System Name:** Be sure the System Name of your new file follows the guidelines mentioned above (e.g., use keywords, all lowercase, no spaces, words separated by hyphens). Also specify the proper file extension (e.g., .pdf, .doc, .xls, .txt)
   b. **Parent Folder:** Click this link to specify in which folder the file will be stored.

**Important:**

Do not store your images or documents alongside your webpages in Cascade.

Be sure to specify the appropriate Parent Folder for your assets:

- Documents and non-image files go in your “docs” folder.
- Images go in your “images” folder.

**Store files in a central location just for files or images:** a “docs” folder for non-image files and an “images” folder for photos.

5. Click “Submit” to upload and save your file.

---

28
Preparing Images for Upload

Before you upload your images into Cascade, it’s important that they meet best practices for the web, which may require modifying image dimensions and file sizes before putting them into Cascade.

With the McCormick template you are using for your website, photos should follow the guidelines below and be cropped to the following dimensions prior to uploading into Cascade. Image sizes are measured in pixels (px).

Images used in feature rotation on homepage
790 px wide by 345 px tall OR 535 px wide by 345 px tall

Images that span the full-width of content area (no sidebar)
790 px wide

Images that span content area of pages with a right-sidebar
600 px wide

Other images used in content areas of webpages
Keep them under ~400 px wide and ~300 px tall

On a page with a right-sidebar, an image that is 250 pixels wide will take up about half the content area when shared with text.

Right-sidebar images
150 px wide (maximum)

Faculty or staff headshots
150 px wide by 225 px tall

Small thumbnails of faculty or staff headshots
67 px wide by 100 px tall

Resolution of all images should be 72 pixels per inch (ppi). You can adjust the resolution of images in a photo editing program.

There are many programs available for cropping, sizing, and optimizing photos, such as Adobe Photoshop, Paint.NET, and GIMP (GNU Image Manipulation Program – available for free on the web).

There are a few important things to keep in mind when preparing images:

• Keep the aspect ratio (the ratio of the width of the image to its height) the same as the original file in order to prevent distortion. No squashed heads!
• Do not increase image dimensions. If you increase an image’s size to something greater than its original dimensions, this will create a pixelated effect. Start with a larger image and size down as necessary.

• If you’re using Photoshop, be sure to select “Save for Web & Devices” when saving your image and adjust the quality to keep the image’s file size under 60 kilobytes (60k) for larger photos.

• Generally .jpg and .png file types work well for most images and photos. Use .gifs for smaller images with blocks of color or animations.

**Uploading Image Files**
The process of uploading new image files is identical to that of uploading new non-image files, except for two key differences:

1. In the Menu Bar, select “New” > “Image – JPG GIF PNG.”
2. When choosing the destination folder, choose your site’s “images” folder rather than its “docs” folder.

Again be sure your asset’s System Name follows best practices mentioned above in “Naming Files, Folders, and Webpages” [page 26] and includes keywords and proper extensions (e.g., .jpg, .png, .gif).
Guidelines for Creating New Content

Before creating new content, it’s best to consider the following:

- Is there a **clearly defined need** for this content? If so, what is that need?
- Who will benefit most from this content, and where can I place it so it will be **easily found** and do the most good?
- Will this content need to be maintained and **updated frequently**?

It’s a good idea to first create all your content in one location such as a Word document so you can review and edit it easily before inputting it into Cascade.

Finally, please note that new pages should be complete (not in progress) when you publish them. Pages that say “Coming Soon” or “Under Construction” are not recommended.

Creating Webpage Content

To add or change content on a webpage, first locate that page in the Navigation Panel. Click on the page you would like to edit.

Once the page has loaded, click on the “Edit” tab located above the page next to the active View tab.

From here you’ll be able to edit any content in most regions of the page: The main content area and the right sidebar.

While you are editing an asset, such as a page, file, or folder, the asset is automatically locked to prevent other users from accessing the same asset while it is being edited. When edits have been made and the asset has been submitted, the asset is automatically unlocked so that other users can access it.
The Cascade Editor Toolbar
Since Cascade uses a WYSIWYG (What You See Is What You Get) editor, the formatting you apply to your content is generally how it will appear on your website.

Cascade’s editor toolbar lets you apply the same basic formatting you’d have access to in any word processor — headers, paragraph (body) copy, bulleted and numbered lists, bold, italics, and much more.

Many of the options on the Cascade editor toolbar (especially the ones on the left side) will be familiar to users of common word processing software. You can perform many of the same actions to format text as you can in a program like Microsoft Word.

Important!
Use only Cascade’s built-in formatting tools!

McCormick IT has configured Cascade’s text formatting to ensure that web pages are uniform and consistent throughout McCormick websites.

As such, editors should refrain from making adjustments to the HTML code that would do things like change the font size, color, or typeface.
However, there are some tools – noted in the graphic above – that may require some additional explanation with regards to how they function.

**Custom Character:** Use this tool to insert special characters such as ampersands, accent marks, letters in foreign languages, artistic symbols and the like.

**Paste:** This function works the same as in other word processing software; however, you should be aware of two things:

1. The pasted item may not appear exactly as you might expect if you are pasting in content from, say, Microsoft Word or a PDF; some software includes additional formatting that is not totally compatible with Cascade. (See the section of this guide on “Copying and Pasting” [page 36].)

2. **This tool may not work in some browsers.** Instead, you’ll need to use the “Control + V” (for PC) or “Command + V” (for Mac) shortcut to paste your content.

**Paste as Plain Text:** If you are pasting content in from Word or PDFs, you may want to use this option – just be aware that it will strip your content of all formatting, such as headers and numbered lists. See the section titled “Copying and Pasting” [page 36] for more information about pasting content into Cascade from outside sources.

The “**Styles**” drop-down menu applies more complex formatting to text and images than Cascade’s WYSIWYG editor. These styles are particularly useful when fitting images alongside your content text.

The styles configured on your website will vary somewhat, but in general the following styles should be available:

- **centered:** aligns text to the center
- **underline:** underlines the selected text
- **back_to_top:** formats text in a smaller font size and a specific color; this style is only for use on the “Back to Top” links used on very long pages of text. Use this style when linking to a “back to top” anchor on your pages.
You’ll notice additional styles such as “image_float_left” and “image_float_right” in the Styles drop down menu. Use of those features is addressed in the “Inserting Images” section of this guide [page 41].

**NOTE:** When changing styles (for example, if you are trying to see whether an image looks better when floated to the left or to the right), you must remove formatting first using the “Remove Formatting” tool noted above. Cascade does not automatically replace one style with another.

**Link/Unlink:** These tools will allow you to create/edit hyperlinks out of any text or image within your body content.

**Insert/Edit Anchor:** Anchors allow you to mark points anywhere on your web page so that they can be easily accessible by users. They are most often used on web pages with a large amount of content, as they offer the ability to go directly to a single piece of content rather than scrolling down through the entire page.

**Insert/Edit Image:** Select this icon to insert an image into your page. Please read the “Inserting Images” section of this manual for important information on this process [page 41].

**Horizontal Rule:** This tool allows you to add a horizontal line at any point on your web page, which may be useful for separating sections of content. You can specify the width and height of the line, as well as choose whether or not it has a shadow.
Insert New Table: If you have information that would be best displayed in a table, you can create it right in Cascade. You’ll be able to specify the number of columns and rows, the padding within each table cell (the space between the content and its borders), the alignment of content within the cells, the border of the table, a width and height.

Cleanup Messy Code: Sometimes, there will be unnecessary code related to your content – code that does not affect the function of the page but might affect its loading time. This tool allows you to remove such code, if it exists in a highlighted section of your content.

Remove Formatting: Use this tool very carefully – it will erase any hard work you’ve done to align text, bold/italicize/underline it or otherwise format it using the other tools. This may come in handy, however, when you’re working with content that has a lot of superfluous formatting that you want to change completely.

You should also use this tool to remove a previous alignment class for an image before adding a new alignment for that image or other created by the style drop down menu.

Edit HTML Source: This option allows you to take a look “under the hood” at the actual code that you’re creating through the Cascade editor. However, it is advisable to leave this alone unless you are familiar with HTML code – changes made here can affect the functionality of your site.
**Guidelines/Invisible Elements:** If you are using any guides to help you format your page (such as a grid), this tool will let you view them or make them invisible.

**Full screen Mode:** Clicking this icon will move your view to a full screen mode in your browser to allow for added working space. Click the icon again to return to the standard view.

**NOTE:** You will notice buttons in the editor toolbar to “underline,” “strike-through” and “indent” text in the editor window. Those styles are **not** preserved when you submit your page in Cascade.

You may **underline text** in Cascade by selecting that text and choosing “underline” from the **styles drop down menu.**

**Copying and Pasting**
As you build and maintain your webpages in Cascade, you can type in your content by hand using the WYSIWYG content editor. You may find you need to input larger amounts of content from Microsoft Word documents or Adobe PDF files.

Before copying and pasting any content into Cascade, please review the following:

In most cases, **copying and pasting directly from Word or PDF documents into Cascade is not recommended.** Documents from word processing programs often contain hidden formatting which can create errors in the way content is displayed on the web.

To remove hidden formatting, it is recommended that you select the “**Paste as Plain Text**” toggle button located in the Cascade editor toolbar. With that button selected, text you paste into Cascade will automatically be stripped of any hidden formatting. Click the button a second time to return to normal pasting mode.
Another option you could use is to **first paste your content into a plain text editor** such as TextEdit or Notepad. Make that content “plain text,” and then copy and paste it again from there into Cascade. That process will strip any hidden code that you may accidentally include with your content.

**Whenever you paste or enter text into Cascade, you will need to reformat your text using the tools in Cascade’s editor toolbar**, creating headers, paragraphs, links, and other formatting manually as desired.

Making sure your text is pasted into Cascade as plain text will ultimately save you a lot of trouble later and ensure that your content appears exactly how you would like it to appear on the web.

**Basic Formatting**

Formatting text as bold, italic, subscript, superscript, and setting its alignment to left, right, or justified, works the same in Cascade as it does in any word processor: Simply select the appropriate text, then apply the formatting you want it to have.

**NOTE:** When the editor is blank, the format drop-down menu will just say “Format.” To make sure the text automatically gets formatted to the “Paragraph” format, hit Enter before typing anything (or select the format “Paragraph” in the drop-down menu). If you do not do this, the text you type will display larger than normal.

**ALSO NOTE:** Cascade is currently configured to remove the “centered” formatting available in the WYSIWYG editor. If you want to center-align any text, use the “Styles” drop-down menu as explained earlier.

**Headings and Subheadings**

It is important to keep your content well organized so your visitors can easily navigate and find the information they need. Use headings and subheadings on your pages to create a visual hierarchy for your visitors, similar to a document outline.

To create a heading in Cascade, select the text you wish to use as a header, then, in the Cascade Editor window, click the “Format” drop-down menu.

---

**Best Practice:**

**Use Headings and Subheadings Frequently!**

- Use “Heading 3” to make a header in your page’s main content area.
- Use “Heading 4” to make a subheader in page’s main content area.

For additional information on using headings and other formatting to improve your website’s searchability, **read the section of this guide titled “Optimizing Your Content”** (page 56).
Select “Heading 3” or “Heading 4.”

The importance of a heading descends as its number ascends, so information used as a Heading 3 should be more important than that of a Heading 4.

NOTE: With this website template, you should not use any “Heading 1” or “Heading 2” formatting, since Cascade automatically formats your site and page titles to those headings.

Inserting and Editing Links

To create a hyperlink on a line of text or an image, highlight that piece of text or the image you’d like to link and click the chain-link button in the Cascade editor toolbar.

From there, you will need to specify the following:

• whether the link target is an internal page or an external URL
• whether the link will open in the same window or in a new window
• what the link’s title (which appears as the floating “tool tip” when a user hovers over link text) will be
NOTE: external links that go to webpages not part of your own site should open in a new window. Internal links to pages on your site should stay in the same window.

To create a link to someone’s email address, select the external link option and type “mailto:” followed by the desired email address in the URL field. For example, if you wanted to link to John Smith’s email address, type “mailto:john.smith@northwestern.edu” (without quotes) in the external URL field. In the “Title” field, enter something like “E-mail John Smith.” When a visitor clicks on that link on your website, their default email program will open a new email to that email address.

You can also use this tool to point to a page anchor, which is discussed in more detail below.

To edit a link, select the link in your editor window and click the chain-link button in the editor toolbar. You can modify the link’s attributes there.

To remove a link, select the link in your editor window and click the broken chain-link button in the editor toolbar.

Inserting Anchor Links

 Anchors allow you to mark specific points anywhere on your webpage that can be linked to from external pages. For example, using an anchor link, it would be possible to link to, say, the third paragraph of a page, rather than the top of that page.
They are most often used on web pages with a large amount of content, as they offer the ability to go directly to a single piece of content rather than scrolling down through the entire page. For example, the “back to top” links often used in long lists are actually pointing to the same page anchor at the top of the page.

**To insert an anchor:**

1. Go to the area of the page where you want the anchor to be (usually near a heading) and click the anchor tool.

2. Enter an anchor name and click “Insert.”

3. When you want to link to that specific section from a table of contents at the top of the page:
   a. Use the link tool as you would for an ordinary link, but rather than choosing an external page to link to, enter the name of the anchor link on the current page.

4. When you want to link to an anchor on a page **other than the one you’re currently editing**:
   a. Use the Link tool to select the page elsewhere in the site.
   b. Enter the name of the anchor link on that page in the “Anchor” field.

---

**Important!**

1. **Anchor names should be treated as System Names:**

   Use lowercase keywords separated by hyphens. Do not use spaces or special characters in your anchors.

2. **Keep close track of your anchor link names!**

   Cascade’s system for linking to anchors in a page does not provide a list of anchors to choose from — you have to enter the anchor name yourself. If the anchor name you enter isn’t exactly right, the link won’t work!

3. **Always test your anchor links after publishing them.**

   If you find problems, it’ll be much easier to correct them immediately than it would be hours or days later.
1. Place your mouse cursor in the area of the copy where you want to place an image, and click on the “Insert Image” icon (the tree picture) in the toolbar.

2. Choose whether you want to create an internal or an external image. An internal image (default option) is a file that is already in the system, or one that you upload. (An external image is one that you link to using a URL. This option is rarely used and is for images hosted by external sites.)

3. Next to Image, you will see two icons – a red cancel/delete icon and an image icon. Click on the image icon.
In the new image chooser window, select the images folder in the asset tree on the left. You can then either navigate to an existing image using the default Browse option, Search for an image, or click on the Upload option to upload a file. If you choose to upload a new image into Cascade, **always upload new images to the images folder.** If you are going to be working with a lot of images, you may want to create sub-folders under the “images” folder to keep them organized.

4. Once you have the image selected, click Confirm to close the image chooser window. The image path will appear in the “Insert/Edit Image” window.

5. In the Alternate Text field, type in a text description of what the image depicts (e.g. “photo of professor talking to students”). This required step ensures that if the image doesn’t load properly, or if a screen reader is being used, the user can still understand what the content is.
While you can specify the width/height of the image here, it is highly recommended that you size photos outside of Cascade, as explained in the section of this guide called “Preparing Images for Upload” [page 29].

6. Click “Insert” for the image to be placed within the copy you selected.

**Working with Images**
Using the tools below you can shift the layout of your inserted images or edit and replace the images on your webpages.

**Assigning an Image Class**
If you’re planning on aligning an image to the right, left, or center, **you must use the “Styles” menu to assign it a “class.”**

**Aligning an Image to the Right or Left**

1. Select the image in the Edit window.

2. Click the “Styles” menu and select `image_float_right` or `image_float_left`. 
This will align your image to the right or left, and add padding around it, which keeps page text from getting too close.

**An Interdisciplinary Disciplinary**

Financial engineering is an interdisciplinary field that uses knowledge from mathematics, economics, operations research, and computer science to develop quantitative models for financial institutions. Some of the institutions develop quantitative models for banks, manufacturing and service firms, and public institutions to make disciplined financial decisions in the face of uncertainty.

**Simulating Crises**

**Jeremy Staum**, Rentas-Nugent Professor in industrial and systems engineering and management sciences, focuses on the big picture, creating simulations that can model an entire global financial institution. Financial institutions have large portfolios that include investments in the world and in different markets. To consider the risk of an institution, the risk of an institution must take into account factors such as stock prices, interest rates, exchange rates, and credit risk.

Part of the recent financial crisis could be blamed on the way financial institutions focus on protecting against losses. While financial institutions focus on protecting against losses, they often underprepare for extreme scenarios, so banks are often unprepared when extreme scenarios occur. The computational tools used to create better models is challenging. As computing power becomes cheaper and easier, financial institutions are looking for more efficient algorithms that can simulate the complex systems that are involved in financial models and that information to get a better picture of the risks that exist.

**IMPORTANT:** Image styles are “additive,” meaning the code created when you choose a style or alignment is not removed if you choose another style for the image. To change an image style or alignment, you must first select the image and click the “Remove Formatting” tool from the tool bar. That step removes the previous alignment. Then you can select a new style or alignment from the styles drop down menu.
Aligning an Image to the Center
If you’re using an image that’s under 450 pixels wide, you have the option of centering the photo vertically between two text paragraphs.

1. In the Edit window, select the image you want to center.
2. Click the “Styles” menu and select center.

Editing and Replacing Images
You may want to alter an image once you’ve added it to a page:

- Select the image in the Edit window and either click the image icon in the toolbar or right-click and select “Insert/Edit Image.”

- You will then be able to change the image path, or use the options on the “Advanced” tab to add more space around the image.

If you have an alternate version of an image that you would like to upload in the place of the current image:

- Navigate to the existing image file in the “images” folder.

- Once the file is selected, click “Edit,” then use the “Upload” option to upload your new image. Cascade will point to the new image instead of the previous one.

Replacing your images assets this way instead of creating whole new files prevents clutter in your images folder.
Right Sidebars

Your website template gives you the ability to include a sidebar on the right side of your webpages, similar to McCormick’s departmental websites. This is a useful place to include contact information, related links, or other important information.

To create or edit a page’s sidebar, select the page on which you would like it to appear, then choose the “Edit” tab.

Scroll down the page to the window that says “Right Sidebar Content.” It is below the page’s main content editor window.
In the Right Sidebar Content editor window, enter your sidebar information. The editor works exactly the same way as the other WYSIWYG content editor, with one exception:

To create the **header** for a section of your sidebar (e.g. “Contact Us” or “Related Links”), you should use **Heading 4**. You can use Heading 4 more than once to create multiple sections in any sidebar area.

Below your sidebar header, enter the relevant content. You can make **bold** any additional text in that section you would like to highlight.

When finished, click “Submit” at the bottom of the page.

**Repeat the above steps on each page you would like a sidebar to appear.** You can copy and paste your sidebar content to each new page once it has been properly formatted in Cascade. You may also choose to have different content appear in the sidebars on different pages.
Building Your Homepage
The Homepage is usually the first thing visitors see when they visit your website.

In the template provided by McCormick, your homepage comes with a built-in structure to it, which includes the ability to display a rotating carousel of images, as well as a content area where you can include recent news or other important information.

In the Cascade content tree, your homepage is called “index” and is kept underneath the top-level folder of your website (e.g. “john-smith”) below the other folders you have created. Select that page.

Click the “Edit” tab and you can change the content on your homepage.
You can **enter content on your homepage** by using the WYSIWYG editor window which appears below the “Slides” section of page in Cascade.

The “Title” field will display a heading at the top of your content area.

The area called “Text” is where you can enter your main body content for your homepage. Please refer to the above section called “Creating Webpage Content” for tips on creating content for your pages [page 31].

When finished, click the “Submit” button at the bottom of your page and then Publish your homepage as explained below.

**Working with Images on Your Homepage**
There are several options for how you can display images on your homepage:

- **You may choose to display no images on your homepage.** For this option, leave the “Slides” fields blank when editing your homepage in Cascade. If no images are selected, the image carousel will not appear on your homepage, only the content area (called “Text” on your homepage in Cascade).

- **You may choose to insert an image alongside your content.** For this option, again leave the “Slides” fields blank so the carousel is not activated.
In the “Text” editor window below the Slides area, select the “Insert Image” button from your editor toolbar. This will insert an image of your choosing in the body content area. Please see the section of this guide called “Preparing Images for Upload” [page 29] for additional information.

- **You may choose to display a single large image using the image carousel.** If you choose only one slide to display, then that image will display continually on your homepage and will not rotate with other images. Be sure your uploaded image meets one of the two size options for carousel images:
  
  - **790 pixels wide by 345 pixels tall.** This image width will make the text box on the right side of the carousel slightly transparent, so you can still see some of the image behind the text box.
  
  - **535 pixels wide by 345 pixels tall.** Using this smaller image width activates an opaque background for the right-hand sidebar.

- **You may choose to rotate images using the carousel.** For this option, follow the instructions below and your homepage will display multiple image slides in a rotating slideshow.

**To add to or change the images in the rotating carousel on your homepage:**

In the area called “Slides >> Slide,” you will see the phrase “Image (535 x 345 px or 790 x 345px).” There, select the desired image from your images folder.

- To select an image, click the “[ ]” link and navigate to your images folder. Select the desired image. **Be sure you’re selecting an image that meets the proper specifications for the carousel: Either 535 pixels wide by 345 pixels tall OR 790 pixels wide by 345 pixels tall.** View more information about optimizing images in the section “Preparing Images for Upload” above [page 29].

- Give your image an appropriate “Title.”

- Enter a brief, descriptive caption for your image where it says “Caption.” This will appear on your homepage at the bottom of the image.

- If you would like your image to link to a page on your website, in the field called “Related Page,” use the “[ ]” link to navigate to and select the desired page on your website. Instead of an internal page, you may enter an “External URL” for the link. Visitors will go to that link when they click the image in your homepage carousel.
If you would like **to include additional images in your homepage carousel**, click the “+” in the upper left corner of the “Slides” section and repeat the above process for the new image(s). Clicking the “-” symbol will remove an image in the carousel.

If you would like **to change the order of images in your carousel**, click the up or down arrows that appear next to the “+” and “-” symbols to shuffle the order of your images.

When finished, click the “Submit” button at the bottom of your page and remember to publish the page.

**Inserting Videos**

**Embedding A Video from YouTube**

You have the ability to embed a video from YouTube so that it plays on one of your site’s webpages. For example, Northwestern and McCormick have YouTube channels which host a variety of informative videos:
http://www.youtube.com/user/NUMcCormick

http://www.youtube.com/user/NorthwesternU

To embed a video so it displays on one of your pages, first go to that video’s page on YouTube. Depending on the video’s settings, you may see one of a few different options for how to generate the embed code:

**Option 1 – Getting Embed Code Using the Share Tab**

On the video’s page in YouTube, if you see the “Share” tab underneath the video, select it. Then select the “Embed” tab under that area.

You will see a window with HTML code in it. You will also see a few options to adjust attributes of the video, such as “Share with playlist starting from ‘current video,’” “Video size,” and “Show suggested videos when the video finishes.”
For the video to fit properly into the content area of your website, you will need to adjust the video’s proportions manually:

Click the drop down menu next to “Video size” and choose “Custom size.”

To the right of Custom size, enter the desired width in the first field.

- To display properly on a page with a right-hand sidebar, your video should be no wider than 600 pixels.
- To display on a page with no a sidebar, your video should be no wider than 790 pixels.

Notice when you enter the desired number in the first field, the proper height appears automatically in the adjacent field, ensuring the video maintains its correct proportions. It also automatically updates the embed code in the window.
After adjusting the video size and selecting your desired options, select all the HTML code displayed in the window. Right-click with your mouse, and select “copy.”

**Option 2 – Getting Embed Code Using the Share Icon**

If you are viewing a Featured video on YouTube, click the “Share” icon in the corner of the video frame (pictured above). You will see a new window pop up in your browser.

In that window, click the button that says “Embed,” and new options will appear.

You will see a field with HTML code in it. You will also see a few options to adjust attributes of the video. For the video to fit properly into the content area of your website, you will need to **adjust the video’s proportions** manually.
Below the check-box options are options to adjust the video size (e.g. “560 x 315,” “640 x 360,” etc.). Choose “Custom.” In the “Width” field below “Custom,” enter the desired width for the video.

- To display properly on a page with a right-hand sidebar, your video should be no wider than **600 pixels**.

- To display on a page with no a sidebar, your video should be no wider than **790 pixels**.

Notice when you enter the desired number in the “Width” field, the proper height appears automatically in the “Height” field, ensuring the video maintains its correct proportions. It also automatically updates the embed code in the window above.

After adjusting the video size and selecting your desired options, select all the HTML code displayed in the window. Right-click with your mouse, and select “copy.”

**Pasting Video Embed Code into Cascade**

After completing all the steps in either Option 1 or 2 above, return to Cascade. In Cascade, navigate to the Edit window of the page on which you would like to display the video.

In the edit toolbar on that page, select the “HTML” icon to open the HTML source editor. This window displays the actual code of your webpage.
Here you may paste in the embed code that you copied from YouTube. Be extremely careful where you insert the new code since you can cause errors on your page if it is inserted in the wrong place.

Unless you’re familiar with editing HTML code, it is recommended that you paste the video embed code at the very top of the page. To do so, place your cursor in front of the very first code in the HTML window, which typically starts with a “<” tag.

**NOTE:** If this is the first content you are entering on a page, there will be no other code in the HTML window. You can click anywhere in the window to insert the embed code.

Right-click with your mouse and select **“Paste.”** This will paste in the embed code you copied when following Options 1 or 2 above.

Click the **“Update”** button at the bottom of the HTML Source Editor window.

Select **“Submit”** at the bottom of the Edit window and you should see your embedded video displayed in the “View” tab in Cascade. From here you can make adjustments as needed to the video placement or other content on the page so it fits properly.

Publish this page to see how it appears on the web by following the instructions in the section of this guide called “Publishing Your Webpages” [page 64].
Optimizing Your Content

As you create your website content, take a moment to read through this section and familiarize yourself with some tips on how to optimize your content for search engines.

Ensuring searchability is a crucial part of building a useful and successful website. This concept is called search engine optimization (SEO). Having excellent content isn’t of much use if users aren’t able to locate it by searching.

While there are no guarantees when it comes to SEO, implementing the following strategies may result in better search results from Northwestern’s Google Search Appliance, which provides search results across the University’s websites, as well as external search engines such as Google and Yahoo.

In addition to improving your site’s SEO, many of the practices mentioned below will improve the experience of visitors to your website and are an important part of complying with accessibility standards for the web.

1. Use Descriptive Page Titles

The page title is the phrase that appears in the top of the web browser bar while a user views a page. Search engines weigh page titles heavily when determining search results. This information also appears as the page title at the top of your webpage’s content area.

You can edit the title of your page under in the Edit tab, in the “Inline Metadata” section where it says “Title.”

2. Use Headers and Subheaders

Google (and thus Northwestern’s internal search engine, which is supplied by Google and uses the same search algorithms) notes information contained in header tags, and gives more weight in search results to pages containing search terms in header tags.

In addition, usability studies have repeatedly shown that users scan web pages, rather than setting out to read them top to bottom, as one would a textbook or novel. This means that concise copy and frequent (but judicious) use of subheadings is vital to making your pages useful to your readers.
Using headings and subheadings frequently is also important to building ADA-compliant pages: Screen readers used by blind people detect the HTML code that indicates headers (<h1>, <h2>, <h3>) and pay more attention to them than they do to ordinary paragraph copy — even if paragraph copy is set in bold or italic.

To create a heading or subheading in Cascade, select the text you wish to use as a header, then, in the Cascade Editor window, click the “Format” drop-down menu:

- For headers in the content areas of your webpages, use “Heading 3”
- For subheaders, use “Heading 4.”

The importance of a heading descends as its number ascends — information used as a Heading 3 should be more important than that of a Heading 4.

With this website template, you should not use any “Heading 1” or “Heading 2” formatting, since Cascade automatically formats your site and page titles to those headings.
3. Link Frequently and Use Keywords

If you mention a page or document in your text, take a moment to link to that page or document, particularly if it’s necessary to complete the task your user is trying to accomplish.

When choosing what words to activate as your link, it’s best to link to the key words in that sentence, not the entire sentence. Also, avoid writing “click here” as your link.

Take the example of this sentence with a “click here” link:

“Professor Smith has worked extensively with the Smith Catalysis Laboratory (click here for more info).”

It’s better to create the link like this:

“Professor Smith has worked extensively with the Smith Catalysis Laboratory.”

For detailed instructions on adding links in Cascade, see the “Inserting and Editing Links” section of this guide [page 38].
It is also important to fill in the “Title” of your link.

The text you enter into the “Title” field shows up as the “tool tip” text that appears over a link when a user hovers their mouse over it on a finished page.

Not only can this information be extremely helpful when navigating our website, it’s also a requirement to keep a web page compliant with ADA standards.
4. **Use Alt Tags on Images**

Cascade requires you to fill in the “Alternate Text” field (producing what’s known as an “Alt” tag) when including any photograph.

An Alt tag contains information on what’s shown in a photo. Alt tags are a requirement for ADA compliance.

![Image insertion dialog box with filled out Alt Text](image_url)

5. **Include Metadata**

In Cascade’s page editor, below the Display Name and Title fields, you will see fields for Keywords and Description.

![Metadata fields](image_url)
In the **Description** field, type a descriptive, concise sentence explaining the contents of the page you’re working on. This description will appear on Google’s search results pages.

Include relevant search terms in the **Keywords** field. This will also help search engines like Yahoo find your webpages.

### 6. Optimize Your Copy

When composing text for your web pages, be sure to include words users are likely to enter into a search engine when looking for the content on your page.

Web users are almost never looking to spend a lot of time on a web page — usually the intention is to find what they’re looking for and move on.

Making your page copy simple and concise, breaking it into more numerous small paragraphs, and using bullet points whenever possible all make it simpler for a user to determine whether or not the page they’re viewing contains the information they’re looking for.

In general, when creating your website content, remember to **write text that’s easy to scan**.
**Previewing Your Webpages**

The quickest way to view the appearance of your unpublished webpages is by selecting the “View” tab on any webpage you are working on in Cascade. There you can preview how your page will look on the web.

However, if you would like to test any pages you are working on in a browser or view your whole website before making it public, you can **publish** your content to McCormick’s development server.

This option provides you and your colleagues the opportunity to review your work as it will display on the web, but still allows you the flexibility to make additional changes before it is fully public.

To publish to the development server only, follow the instructions in the section below called “Publishing Your Webpages” [page 64].

In Step 2 under “Destination,” be sure that only the box for “Development Server” is selected. Uncheck the box for the “Live Server” if it is checked. Then click “Submit” to publish.

Then in your web browser, go to:

http://faculty-sites-dev.tech.northwestern.edu/john-smith

*[Be sure to replace “john-smith” in the URL above with the name of your actual website as it appears on your topmost folder in Cascade.]
There you will see the most recently published version of your website. You can continue to make edits in Cascade and republish to the development server as often as you would like.

When you are ready to make your site (or any pages you’ve been testing) public, follow the complete instructions below.

**Publishing Your Webpages**

Clicking “Submit” at the bottom of the page you’re editing saves your changes in Cascade. However, it will not yet appear on the web.

After submitting your changes, your page still needs to be uploaded to the web server. That process is called Publishing. This process explains how you can publish certain portions of your website or the entire site.

The publishing process is simple:

1. Select either the individual page you would like to publish, the folder you would like to publish, or if you are publishing your entire site for the first time, navigate to the folder in the content tree that contains your entire site (e.g. “john-smith” or “your-site-name”). Then click the “Publish” tab at the top of the page preview window.

2. You’ll see three areas of the screen, where you’ll configure the publishing process for your pages:
• **Page Configuration:** Refers to the type of page you’re publishing; there is no need to alter this area.

• **Destination:** This area shows to which servers you’ll be publishing your edits. Here you should see two options with check boxes. Those options are the two servers you can publish to:
  - “Development Server” is your site’s development server, on which you can test your website.
  - “Live Server” is the live server. **This option makes your content fully live and viewable by the public.**

If you only want your changes to show up on the development server only (for example, you might want to show someone a set of proposed changes to your website), make sure only the box next to “facsites-dev” is checked.

**If you want your changes to go live immediately, check both boxes.**

• **Options:** “Generate a publish report message,” if checked, means that you’ll receive a message within Cascade’s internal messaging system (viewable from your Dashboard or from the “Messages” link in the Quick Links menu) confirming that your page was published, and what errors, if any, occurred during publication. This is good to have, but not necessary.
“Publish” and “Un-publish” mean exactly what they seem to:

- “Publish” updates the page you’ve altered on the server
- “Un-publish” removes the page from the server entirely.

3. Once you’ve selected the configuration you want, click “Submit” to publish your page. You’ll get a confirmation message in a green bar at the top of the page.

To publish an entire folder, navigate to the folder you want to publish in Cascade, then follow the steps to publish as listed above.

Publishing is generally immediate and can be done as often as needed.

To view your latest published changes in a browser, you may need to refresh the page or clear your browser’s cache so it pulls the most recent information from the server.

IMPORTANT: If you’ve made updates to the order of the left navigation in any way — this includes adding a new page, changing the order in which the pages or folders appear, or changing the display name of any pages in the left navigation — you must republish the entire folder in which the updated items appear to see those changes reflected on the live site.
**If Your Webpage Isn’t Loading Correctly**

Here are a few troubleshooting tips to try if you find a webpage isn’t loading correctly on the web:

**After checking that all the links and formatting are correct on your page in Cascade, be sure you have published the page.**

Try publishing the page a second time if:

- the page isn’t displaying the same on your website as it appears in Cascade
- the page isn’t loading correctly
- there are broken links on the page

If the page still doesn’t load correctly after publishing, it might be a caching issue related to your Internet browser:

- Try to reload the page in your browser without cache by selecting Ctrl+F5 (for Windows) or Cmd+Shift+R (for Mac).

If the page still doesn’t load correctly, it may still be in the process of publishing. You can **check the publisher queue** in Cascade to see if it that page (or other assets) is still in the process of publishing.

To check the publishing queue:

- Select the Cascade “C” swirl on the top left of the toolbar, then select “Publisher” and select “Active Jobs.” There you can see what assets are in the process of publishing.

If the page has been published and the problem still remains, or the publisher appears to be stuck, you may **contact McCormick IT** at web-updates@mccormick.northwestern.edu. IT may be able to address the problem.
McCormick Web Style Guide
For general content formatting and style guidelines, please refer to Northwestern University Style Guide, available at:

http://www.northwestern.edu/univ-relations/publications/resources/styleguide.html

It is also recommended that you adhere to the style and formatting suggested in this manual as well as the rules below. The below rules particularly apply to contact information listed for yourself or your offices and laboratories.

**Phone numbers:**
- 847-000-1234 (no periods.)
- “Phone” and “Fax” should be set bold, and should only appear if both a phone and fax number are present. (If there’s only one number, visitors are likely to assume it’s a phone number rather than a fax.)

**Job Titles:**
Job titles are to be displayed in italics, unless they are set as a Header above the name of the staff member.

**Staff Names:**
Staff names should appear in bold.